IRC Client Setup Guides
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Step by step guides for configuring various IRC clients for use with the Fuel Rats IRC server

(D Privacy notification

Some clients offer you to enter your Real Name as part of their connection options. Please be aware that if you enter your real name
here, it will be visible to anyone on IRC. For privacy reasons, we suggest not filling in this field, or using your CMDR name.

é Kiwi IRC

Kiwi is a web-based solution. There's two options, using the simple version via our own website or the full version with a few more features available.
Kiwi is free & opensource.

Contents Related articles
1. General ®* |IRC FAQ
information ® |RC Client Setup Guides
2. Connect with
full version
3. Optional Fuel Rats KIWI (SSL)
settings

Fuel Rats KIWI (Non-SSL)

The non-SSL link may be needed if you use Firefox.

Development/full version KIWI *

* Currently this version is problematic, as it relays your connection details in a manner that may get you disconnected. We
advise you do not use it until this has been fixed.

Official Kiwi IRC documentation

Since kiwi is web-based there's no download & installation needed.


https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-kiwi-general
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-kiwi-general
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-kiwi-connect
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-kiwi-connect
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-kiwi-optionalsetup
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-kiwi-optionalsetup
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
https://kiwi.fuelrats.com:7778/
http://kiwi.fuelrats.com:7779/
https://kiwiirc.com/nextclient/
https://kiwiirc.com/docs/

If you go with our Fuel Rats version (our website widget), you won't have any features such as automatic identify on login, so you will have to do such
things manually via nickserv commands.

The full version of Kiwi has a bit more features:

Configuration with automatic login
Support for desktop/phones/tablets
Themes

Multiple languages

Plugins / User scripts

Both versions have custom highlights (pings on words of your choice) under Settings > Notifications > Highlight on words. For example if you wanted
to be notified of a new case you'd enter "ratsignal” without the quotation marks.

2 - Connect with the full version *
( *see note above about current issue with this IRC client)
Setting up the network is fairly simple and will be remembered on the computer you are using for next time.

If you enter your password for the registered nick into the password line, kiwi will identify with NickServ for you.

Server details

Server | The Fuel Rats IRC Network v

Password

Mickname

YourRegisteredRCnickFrom\Website

Advanced =

Connect To Network

Danger Zone

¥ Remove network

You don't have to set up kiwi to rejoin channels every connection but you have to join them at least once using /join #fuelrats, /join #ratchat for the
client to remember them.

3 - Further optional setup

Once connected, you can adjust a few other things if you want. This step is absolutely optional.



Theme <

|:| Show autocomplete list

|:| Use monospace

Chat Messages

Message Layout
|:| Show timestamps

E Use 24-hour timestamps

E Show emoticons

|:| Block new private messages

1000 Messages in scrollback

|:| Extra formatting

|:| Colour nicknames in messages

Notifications

|:| Include join/part messages as activity
|:| Mute sound notifications

Highlight on words (space separated)

ratsignal

@ HexChat

A step by step guide to getting HexChat (a free IRC client for Windows and Linux) up and running with the Fuel Rats IRC for first time users



Contents Related articles

1. Installing HexChat * |IRC FAQ

2. Connecting to the Fuel Rats IRC server ® |RC Client Setup Guides

3. Changing the appearance

4. Sounds and Alerts

5. Tips and Tricks Download HexChat | Download Themes

Official HexChat documentation

1 - Installing HexChat

Installation for HexChat is very straight forward. Follow the instructions in the installer with the default options being sufficient for use with the Fuel
Rats IRC. If you run Windows 10 just download and the Windows 7 installer.

If you wish to save space and are comfortable with the English language, you may optionally uncheck Translations. We recommend keeping the auto
updates option checked so the client notifies you when a new version is available however this is personal preference and of course optional!

The 'Portable Installation’ option stores HexChat settings in the program directory so it can easily be copied to another computer, although under
Windows, you may have to install HexChat to a different location (for example D: drive, or a USB stick) to avoid having to run the client as
Administrator.

@ Non-portable mode (default option) settings location

Windows: %APPDATA%\HexChat
UNIX/Linux: ~/.config/hexchat

@ 32-bit vs 64-bit

Some Cmdrs reported problems with getting alerts to run with the 64-bit version of hexchat on Windows. if you run into such problems,
install the 32-bit version.

2 - Connecting to the Fuel Rats IRC server

The first time you run HexChat a Network List window will appear. Enter your desired IRC nicknames (the 3dis optional). In most cases this would be
your CMDR name in-game. Use underscores instead of spaces, if you have any in your name.

The ‘User name’ field is the name that shows up if anybody queries who you are in IRC and should match your registered IRC nick (see the IRC FAQ

).


https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-hexchat-installing
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-hexchat-connecting
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-hexchat-appearance
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-hexchat-alerts
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-hexchat-tips
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
https://hexchat.github.io/downloads.html
https://hexchat.github.io/themes.html
http://hexchat.readthedocs.io/en/latest/index.html
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ

hat: Metwork List

User Information
Mick name: Ratling[PC]

Second choice: | Ratling

Third choices
User narme: Ratling
Metworks
2600net ~ Add
2ch
Remove
AccessIRC
AfterNET Edit...
Aitvaras Sort
Anthrochat
W Favor

APPSR

Skip network list on startup [_] Show favorites only

Cloze Connect

Example entries, your name may differ!

Once you have entered your nicknames, click on the ‘Add’ button. This will insert a new network at the top of the list. Click/type to rename the network
to FuelRats as shown below. Press enter to save the name.



&% HexChat: Metwork List

User Information

Mick name: Ratling[PC]

Second choice: | Ratling

Third choice:
User narme: Ratling
Metworks
FuelRats Add
2600net
Remove
2ch
Edit...
AccessIRC =
AfterMET Sort
Aitvaras ” Favor

Skip network list on startup [_] Show favorites only

Cloze Connect

With the FuelRats network selected, click on * Edit... ". This will open up a 2 nd window to configure how to connect to the Fuel Rats IRC server.



& HexChat: Edit Fuelrats H

irc.fuelrats.com,/+ 6697 Add

Servers | Autojoin channels | Connect commands

[] Connect to selected server only

Connect to this network automatically

[ ] Bypass proxy server

Use 55L for all the servers on this network
[ ] Accept invalid 550 certificates

Use global user information

Mick name:

Second choice:

Real name:

User name:

Login method: | 5ASL (username + password) W
Password: TTTTTTYYITIY

Character set: UTF-2 (Unicode) L

Close

To add a server to the list at the top, click * Add ’, type irc.fuelrats.com/+6697 and press Enter to save. Copy all other settings as shown. If you plan
on using HexChat for more than just the Fuel Rats, you can uncheck “Use global user information” and specify your per-network nick names here.

@ Important Note about Login Method

For new joiners who have yet to set up IRC authentication (see the IRC guide), set the ‘Login method’ to Default with no password. Once
you have set up your IRC authentication this can be changed as shown in the screenshot above.

The ‘Autojoin channels’ tab allows you to specify which channels HexChat will automatically join when connecting. We use primarily 2 channels that
you will normally need to be connected to. #FuelRats (where official rescues are conducted) and #RatChat (informal chat and rescue discussion
channel).


http://irc.fuelrats.com/6697

Channel Key (Password)
ZFuelRats

#Ratchat

Servers| Autojoin channels | Connect commands |

[] Connect to selected server only

Connect to this network automatically

[ ] Bypass proxy server

Use 55L for all the servers on this network
[ ] Accept invalid 550 certificates

Use global user information

Mick name: |

Second choice: |

Real name: |

User name: |

Login method: |SASL (usernarme + password)

Paszword: |lulllll-|---lulllll-|

Character set: UTF-2 (Unicode)

Adding channels is done in the same way as the previous list boxes. Click ‘Add’, type the name and press Enter to save. Repeat this process for as
many channels as you wish.

When you are happy with your settings, click ‘Close’ to return to the Network List window followed by ‘Connect’ to begin your IRC session. If you
have replicated all of the check boxes as shown above, next time around the client will automatically connect to the Fuel Rats IRC.
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Congratulations! You have connected to the IRC.

@ SSL Certificates

The first time you connect, you may receive a notification that the server certificate has changed. This is normal. The tech rats sometimes
update the certificate so don't be surprised if the message pops up again 6 months down the line!

The general HexChat layout has channels you are connected to on the left (the top entry is the Status window which shows important messages from
the server) the main chat area with nicknames and time stamps in the center and connected users listed down the right side when viewing a channel.

3 - Changing the appearance

The appearance of HexChat can be customized in various ways including layout, fonts and colors. To begin changing these settings, within the main
HexChat window click on the Settings menu followed by Preferences .

Settings  Window Help

o= Preferences

Auto Replace...
CTCP Replies...
Dialog Buttons...
Keyboard Shortcuts...
Text Events...

URL Handlers...

User Commands...
Userlist Buttons...
Userlist Popup...

The main settings window will open. This may appear somewhat confusing at first glance but fear not, it's all rather logical! A common request is to
change the background and text colors to a dark theme. Click on Colors in the Interface section. By reversing Background and Foreground (click on
each one to open the color picker) a darker theme can be quickly achieved.



# HexChat: Preferences

Categories Colors
= Interface
Appearance Text Colors
Input box mIRC colors: ﬂ..-....ﬂﬂ......
User list Local colors: ﬂ..-....ﬂﬂ......
Channel switcher Foreground: . Background: J
- Chatting Selected Text
General Foreground: J Background: .
Alerts
Sounds Interface Colors
Logging Mew data: . Marker line: .
Advanced MNew message: . HAoway user .
= Metwork Highlight: . Spell checker: .
Metwork setup
File transfers Color Stripping
ldentd [] Messages
Scrollback
Topic

Cancel QK

Changing of fonts and colors is of course personal preference and some experimentation will be required! To preview your changes you need to click
on OK which closes the window and applies your chosen settings. You'll have to open/close the Preferences window until you reach your desired look
(takes a little while to get it right). Alternatively you can visit the Hexchat website and download pre-prepared themes (see link at the top in Related
Articles).

Other settings you may wish to experiment with:

* Interface Appearance Window Opacity
Slide to make the main window transparent
® Interface Channel switcher Switcher type
Select Tabs to free up extra space on the left and move the channel selectors to the bottom
® Chatting Logging
Increasing the number of scrollback lines can be useful when dispatching multiple cases, or if you leave your client running for long periods of
time and need to scroll up to check on previous cases in #FuelRats!
® Chatting Alerts
See the dedicated section on Sounds and Alerts

4 - Sounds and Alerts

As a Fuel Rat it's important (perhaps essential!) to know when a new case is arriving, or when another rat mentions your name without having to keep
one eye glued to the IRC window all the time.



The Alerts section in Preferences requires a few basic changes to ensure you are "pinged” when a new client arrives. The trigger for most new cases
is Ratsignal and this has been entered into the "Extra words to highlight" box shown below. If you require a highlight on a multiple-word phrase, you
will need to surround it in quotes, "like so". Take note multiple highlights are separated by a comma, but must not have a space after it.

® Squeaking!

Take care not to write Ratsignal in the IRC chat! You'll squeak and everybody will hear! Beware!

% HexChat: Preferences

Categories Alerts
= Interface
Alerts
Appearance
Channel Private Highlighted
Input box Message Message Message

User list Show notifications on:

Channel switcher Blink tray icon on:

Blink task bar on:

oodg
& & O
[ & & O

Colors
= Chatting Make a beep sound on:
General [] Omit alerts when marked as being away
Alerts [ ] Omit alerts while the window is focused
Sounds
Logging Tray Behavior
Advanced Enable system tray icon
= Metwork L] Minimize to tray
Metwork setup [] Close to tray

Automatically mark away/back
File transfers [ y w

(] Only show notifications when hidden or iconified
Identd

Highlighted Messages
Highlighted messages are ones where your nickname is mentioned, but alsa:

Extra words to highlight: Ratsignal
Mick names not to highlight: MickSery, Chan5ery, Infosery, M, 0
Mick narnes to always highlight:

Separate multiple words with commas.
Wildoards are acoepted

Cancel QK

The 'Make a beep sound on: Highlighted Message' option has been checked. Highlighted messages are your nick name and anything that has
additionally been entered into the 'Extra words to highlight' box. The default sound is your system's instant messenger alert sound however you can
change the sound played in the Sounds section:



% HexChat: Preferences

Categories Sounds
= Interface
Event Sound file
Appearance Add Notify
Input box Ban List
User list Banned

Channel switcher Beep E\Sounds\Squeakwav

Colors Capability Acknowledgement
=l Chatting Capability Deleted

General Capability List

Alerts Capability Request

Sounds Change Nick

Logging Channel Action

Advanced Channel Action Hilight
= Network Channel Ban

Metwork setup

Channel Creaticn
Channel DeHalfOp
Channel De0p

File transfers

|dentd

Channel DeVeoice
Channel Exempt
Channel Half-COperator

— e W
Sound file:
Ef\Sounds\Squeakowav Browse...| |Play

Cancel QK

The file location for your sounds may differ. For HexChat the sound file needs to be a .wav format. There are many other events in the list that you
may wish to customize however the Beep sound will cover the highlighted text.

As an additional customization you may also wish to change the highlighted text color and this is set in Interface Colors Highlight.

An example HexChat setup:



Settings  Window  Help

- to the
ADD FRIEND

(Default I-ce.Y Ek hit
; i

‘Defau ey E).
T Invite to wing.

(Default key 4),
it to

FuelRats |#fuelrats | #RztChat | Zatie[PC] b4

5 - Tips and Tricks

Did you know you can use the tab button while typing a message to automatically complete another user's name? By typing the first 2 or 3 letters and
then pressing the tab key, you can cycle through nickname matches without having to type the full name. Very handy to avoid spelling mistakes!

On the subject of spelling, in HexChat you can right click on words while typing for spelling suggestions too!

Good luck CMDR, and fly safe with HexChat! o7

¥ AdiRC

A step by step guide for setting up the freeware client for Windows, AdilIRC (provided by Vanya Pavlovich)

Contents Related articles
1. Installing * |IRC FAQ
2. Connect ® |RC Client Setup Guides
3. Customization
4. Tips

Download AdiIRC | Download Themes

Official AdiIRC documentation

1 - Installing AdiIRC

Download the stable release installer version from link above - that matches your operating system. Run the .exe and follow the steps in the install
wizard. Keep settings as is, changing the installation location if you so wish.

2 - Connecting to the Fuel Rats IRC server

When you start AdiIRC a quick connect window will open. In the bottom right, click Advanced ServerList.


https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-adiirc_installing
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-adiirc_connect
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-adiirc_customization
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-adiirc_tips
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
https://www.adiirc.com/download.php
https://dev.adiirc.com/projects/adiirc/boards/6
https://dev.adiirc.com/projects/adiirc/wiki

# AdIRC - Quick Connect

Mick: Altemative:
| || |
|Isemame: Fullname:
| || |
Server Mame: Part:
| - | | - | []1s 55L
Password (if required):
| |
Join Channel(s):

o Ad

Log On

] Dont show this box again Advanced Serverlist

A new window will open. Click Add new network. Name it FuelRats and copy from blank network. Then Add.

AdilRC - Server List — O e

|T}'pe to search... |
Server List

Here you can add and edit servers and networks

Press Add new network to get started

# AdIRC - Add Metwork

Metwork name: |FueIHat5| |

Copy from: | Blank networl “ |

Add || Cose |

Save | | Cloze | I Add new netwark I 'g [] Show serverdist on startup




The window will change to show all the details of the server you wish to add.

# AdilRC - Server List

Server List
|T!r'I:'E to search... | General  Servers Channels Commands S5SL Proxy  Misc
Mick:: | | Altemative nicks: Add
Fullname: | | Remove
semame: | |
Password: | |

[] Show password

Login Method: Encoding:
Default ~ | | Unicode (UTF-8) o

[] Connect to this network on statup [ Priortize IPv6

[ Minimize the server window [] Use this label as network name
Connect Connect in a new tab
Save Cloge Add new network g [] show serverist on startup

2.1 - General

Here is the general settings of your nickname, login, and connection type.

-'Nick' is the nickname you will connect with and should be one of your registered nicks (See IRC FAQ on registering a nick http://t.fuelr.at/ircfaq).
-'Fullname' is what appears after your vhost via a /whois. For example Rat Jackson may choose to have Jackson Smith as their Fullname. And on a
Iwhois, would show up as Jackson[PC]!Jack@jackson.rat.fuelrats.com * Jackson Smith. Fullname has no effect on logging in/identifying/registered

nicknames, you can have it as anything you wish.

-'Username’ is what you will be using to identify/log in to the IRC server. Set this as your base nick, your nick without platform [tags]. For example if
your CMDR name is Jackson, you will have your base nick as Jackson, and your tagged nick as Jackson[PC]. Enter Jackson as your username.

-Password is the password you entered in the pop up box when registering the nick on the website. The nick being, the same one you are connecting
with as 'Nick' above. Note the

-'Alternative nicks' is what you will connect with if ‘Nick' is unavailable i.e. due to a ghost or second connection already open. Usually you can leave
this as your base nick/the same as 'Nick' but with no platform [tag].

-Login Method change that from default to SASL (username + password) this will have AdiIRC use your username and password from above to
identify you when you connect, serving the same purpose as a sign in on other sites and services.

Check Connect to this network on startup to have AdilRC connect to the fuelrats IRC server when you launch it, OR check Show serverlist on startup
to have this server window on startup and wait for you to press Connect.
-Connect will have Adi connect to the server. Don't click this until you're done setting up the connection


http://t.fuelr.at/ircfaq

# AdilRC - Server List

Server List
|-|_‘J-'I3lE to search... | General Servers Channels Commands SSL Proxy  Misc
e [l | Meratve s =
Jackson
Fullname: |Jacksnr1 Smith | Jad{sun_
Jackson__
|zemame: |Jacksur1 | Jackson___
Password: |------|----- |
[] Show password
Login Method: Encoding:
|S.PLSL ({ugemame + password) w | | Unicode (UTF-8) w
Connect to this network on statup || Prioritize IPvE
[] Minimize the server window [] Use this label as network name
| Connect | | Connect in a new tab |
| Save | | Close | | Add new network | a [] Show serverdist on startup

2.2 - Server
Here is where you define the server you connect to

Click Add. Hostname will be irc.fuelrats.com. Port will be +6697 (Be sure to include the+). Enable SSL. Click save.



AGiIRC - Server List -0

|T‘;’pEtDBEarch___ ’“v:*-| General Servers Channels Commands SSL Proxy  Misc

ovE

# AdIIRC - Edit Server

Hostname: |irc.fuelrats.cnm| |

fe Igx

Pot: |+6697 | wn

Description: | |
Enable 551
[] Enable STARTTLS

| Save I | Close |

| Save | | Cloge | | Add new network | ﬁ Show serverist on startup

2.3 - Channels

These are the channels you will join when connecting to the server.

Click Add. Channel #ratchat (our social channel) and #fuelrats (our rescue channel). No password. Join on connect.



AdilRC - Server List — O ®

|T‘1’DEtDSEBFC|'I--- | General Servers Channels  Commands SSL Proxy  Misc

M
=

# AdiRC - Add Channel

Channel: |#fuelrats| |

Enable autojain e | |

Delay: T Description: | |
Delay between joins: seconds Join on connect

[] Minimize on join

I Save | | Close |

| Save | | Close | | Add new netwark | |ﬁ [] Show serverist on startup

2.4 Commands

Here you can specify a command to run when you connect to the server. It is recommended to run /query MechaSqueak[BOT] as that will open a PM
window with the bot you can use to run commands and facts for personal use and reference without cluttering #ratchat.

2.5-SSL

Here you can specify the SSL settings you connect with. If you don’t know what these are, leave them as is.

2.6 - proxy & Misc

If you don’'t know what these are, leave them as is.

2.7 - Connect

Now that you have your server connection all set up, click save then go back to the general tab. Click Connect. Voila, you are now connected to the
Fuel Rats IRC via AdilRC.



Commands Window Help
Ba=EN
B #CrunchysCave B #doersofstuff [ #rattracker £ Jindrolim[PC] £ MechaSqueak[BOT]

[16:00:40] Aybars: Please add the following rat(s) to your friends list: Attract, Da’oud al Zarg. I
mboyscout [15:51:43] jacke1210abc: There are a few links on this page you should read
[16:00:50] +Razor [Dispatch]fpcir Aybars [15:51:49] heck out step 6
[16:00:51] \ybars: To send a friend request. go to the menu (Hit ESO), click friends and private groups
and click ADD FRIEND [15:54:10] [Paperwork] Paperwork for rescue #3 (Strykerme83) has been completed by Altsain
[16:01:13] lokolokomani am at MC 811 [ 0] isearch MCCB11
[16:01:24] ffrs 21 [15:54:40] +Razor[Dispatch]|Need someone to take over soon. sleep..
[16:01:35] fr- [15:54:46) Nearest matches for "MCC811” are: "MCC 811" [1]. "MCC 813" [2]. "MCC 818" [2]. "MCC 39" 3]
[16:01:37] fient in mm
[16:02:00] e #1 :54: urnamed|811
[16:02:11] e+ : urnamed|lt's my friend
116:02:32] +Razor [Dispatch]|Aybars: ok.. DO NOT DO THIS NOW.. I'l have some instructions for you... please read them “Jquits: De
nd let me know if you understand them. Ok?
[16:02:42] Aybarsiok
[16:02:51] +Razor[Dispatch]ficrinst Aybars
[16:02:51] \ybars: Once you get told (NOT NOW!), please log into OPEN PLAY, enable your WING XekralPrydon|Razor[Dispatch] Wait... sleep? Who needs sleep? And here 1 was thinking you were invi
IBEACON and finally INVITE all your assigned Rats to a Wing! 5:57:05 “Jquits: jacke 12 10abe (184364d6@4BEA L 4IP)(Quit: FuelRats
[16:02:59] +Razor [Dispatch] lpcheacon Aybars
[16:03:00] 107 ]|Aybars: To light your wing beacon. go to the right-side panel (Default key 4), navigate to
the functions screen (Default key Q). select BEACON and set it to WING KiwilRC)
[16:03:11] +Razor|Dispatch]ltpcwing Aybars 8:05] Case Johnathan Soto cleared! alierum, do the Paperwork:
[16:03:11] \ybars: To send a wing request, go to the comms panel (Default key 2), hit ESC to get out [16:01:19] +Razor[Dispatch][Sorry lokolokoman I rather have 3 drilled rats on a cr
f the chat box. and move to the second panel (Default key E). Then select the CMDR you [16:01:46] P : [Component: Statuspage Hosted Pages] went from Degraded performance to
ant to invite to your wing and select Invite to wing.

3 - Customization
AdiIRC has a huge range of customization. You can dive right in from the options button (Wrench and Screwdriver icon).
-Colors-

The first thing you may want to change is the colours. From text/background to joins, quits and whois, the colours can all be changed here. Many
chose to swap the 'background' and 'normal’ colours for a black background with white text look.



AdilRC - Options - O X
|T}'pe to search... 4 | Calors
Cwvenide Windows theme colors
Away N
Backgrounds Baclground _ MNormal
coles Your System I
DCC Highlights I Action I
Editbox Ciep I - I
Emoticons Parts Quit _
e Tope I - I
Names I /hois I
Fonts Kick I Ciicr o I
General Links S Notice I
Highlights Notiy I nick I
lcons Baorder Lines
Ignore Unread Line Mick column divider
. Selected background I sclected text
Inline Images
_ Selected nick line background [ <'=cted nick line text
inks Menubar
Logging Background I -
Media Player Toolbar
Messages Background I -
Monitor Panels Switchbar
Background _ Inactive
Mouse
. Nomal Message I
Nick Colors Highlights I ;<= I
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-Editbox-

Here you can set Tabcomplete order to last spoken order. This has the tabcomplete function cycle through possibilities starting with which one last
said something. Helps prevent you from accidentally pinging the wrong person in a conversation.



-Fonts-
For the Fuel Rats, you may find it useful to be able to distinguish between various similar characters such as I-I-1 O-0-Q-D and B-8. Some good fonts
include operator mono, Consolas (mono), serif, Gadugi and Adi's default font; Verdana.

Fonts can be set individually for all the sections of AdiIRC from the messages, to the menu bars and edit-box.



AdilRC - Options - = »

|T}'pe to search... | Fonts

Font:

Poway ‘Messages V| I T

Backarounds

Colors Nickiist fort weight:
‘PFEFD‘ w | |[] talic

Editbox D Bald
[] Underine

Emoticons
Events
_"-I'EH Treebar font weight:

— |Senrer w | ] talic
General [ Bold
Highlights [] Underine

lcons

lgnore Choose font .

Inline Images

Links Font: Fort size:
i Gadugi ~ | |9 e ltalic
Lagging adugi | | tok
Media Player 5 Underine
Sample

Messages
Maonitor Panels
Mouse AaBbYyZz
Mick Colors
Micklist

Motify Set As Default
Proxy [] Use Default
Cluick Connect I K I | Cancel
Server
Shortcuts
Sounds
Statusbar

Switchbar

Sysinfo
Tips
Tray lcon
Treebar

Windows

Save || Reset all || Reset || Cloze

e

-General-
Contains a variety of setting from having AdilRC start when windows starts, allowing multiple copies of the program and confirm when closing window
- to update the frequency at which it checks for updates.



AdilRC - Options

|T:.-'|:ue to search... | General

[] Start with Windows

Away
[] Start minimized

Backarounds

Colors [] Mlow only one copy of AdilRC running

e [] AdilRC is always on top of other windows
Editbox Disable CTCP reply

Emoticons [] Keep channels open on part

Events Keep channels open on kick

Fonts Rejoin channels on kick
Rejoin channels on reconnect

Highlights [] Confirm closing AdilRC while connected to a server
leons Confimm disconnecting when clicking connect icon
lgnore

Confirm closing server windows

Inline Images
Caonfimm closing channel windows

Links
Logaing Confimm closing private windows
Media Player [] Associate AdilRC with inc(s):// links
Messages [] Check association on startup
Maonitor Panels [] Hide channel key
Mouse
Mick Caol
fc ) o Check forupdates: | Weekhy w | [] Include beta versions
| Nicklist
ickli
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Proxy Global shortcut to hide/show main window: |
Quick Connect Choose Language: en-LS e
Server 2 =
Barder size: -
Shortcuts
Sounds
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Sysinfo Add
Tips
Tray lcon Remove
Treebar
Windows
Save Reset all Reset Close 9
-Highlights-

A powerful tool in the rat's arsenal for being informed. You can set up to be pinged on just about anything in any variation.



Keep '$me' as is. That will make it so that anytime your current nick is included in a message, it will ping you to get your attention. No need for @-ing
somebody, simply type their name.

| @ Edit Highlight X
Highlight:

|$I'I'Ie

Match on: | Message b

[] Case sensitive [ ] Regex

Flay sound w

File: |C:\Winduws‘media\Winduws Ermo | Browse 2

Flash message time(s)

Metwork name or Server address:

Channelis):

Message:
[snick highlighted you on Schan $+: $1- |

Run command:

| |
o | @

You can add your own custom highlights. Click 'Add" and a window will open where you can set specifics.



Highlight:
| |Platform: PC
Match on: | Message A
I [] Casze sensitive [] Regex
Play sound w
File: |D:'-.Pn:ugram FiIes'-ﬁdiIHC'-Jemergen| Browse 2

Flash message time(s)

Metwork name or Server address:

Channel(z):
|#fuelrats |
Message:

Fun command:

| ||
o | @

'Highlight' is the word that when said, will ping you. 'Message' will have it ping if it is part of a message. 'Nickname' will ping whenever someone with
that nickname speaks. 'Regex’ allows for an amazing range of customization and variation on a single highlight without having to make multiple; if you
don't know what regex is, leave this off. Sound can be customized to play a single beep, defined by your system sounds, or an audio file you pick.
Compatible sound file formats include .mp3 .wav and .wma. 'Channel(s)' allows you to set the highlight to only go off when said in specific channels.

Set as one of your highlights for the #fuelrats channel. This will notify you when a new client comes in looking for help. And prevents it from making
undue noise should someone use that word anywhere else. You may also find it useful to have a ping specifically for the platform you are ratting on,
so as not to be bothered when cases come in for a platform you do not play on. For this, instead of "RATSIGNAL", set "Platform: PC" without the
quote, XB or PS as applicable. RATSIGNAL

-Logging-

This is what tells your client to log the history of channels into a text file. Highly recommended as it lets you search back through previous
conversations, events, and in general record a history.

-Log channels - on

-Log Private chat - on

-Strip mIRC tags - on (otherwise you will end up with a bunch of clutter characters in your text logs that make it harder to read)
-everything else can be left is or changed per preference.

-Messages-
Customise how messages appear from timestamps to scrollback.
It is recommended to increase the max buffer from 500. This will allow you to scrollback further in time before you have to resort to checking logs.
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Fonts
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W
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-Nick Colors-

These settings override anything in -Color- above. Here you can set certain nicks/tags/roles to be differently coloured to help you more easily identify
people and their roles. For example having anyone with "spatch" in their name or tag can help pick them out amongst a busy rescue channel.



Likewise setting different colours for vhosts/roles (*@*bot*) (*@admin*) (*@*.op*) (*@*netadmin*) (*@*techrat*) (*@*.overseer*) (*@*.rat*)
(*@*recruit*) can help you learn who's who and their jobs as well as pick them out of a crowd at a glance. Or if you want our favorite Sheet to be his
radiant Orange self. Or you may wish to turn on random nick colors. This can be confusing at first, but some find it helpful when every nick is a
different colour.

Edit Mick
AdilRC - Options Nick Color:  Method: - O X
[T (= |
Apply colorto users matching:
|T1_,.'pe to search... | Mick or Address (nickluser@host) separate with comma:
A 'Sﬂﬂtd"l' |
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-Nicklist-
This is the displayed list of users connected to a channel. Not much to change here outside of preference. Can be handy.

-Quick Connect-

This is where you can find the less detailed info and settings you dealt with in section 2. Best to leave them as is/blank to prevent interference with
your already made connection settings. The Advanced ServerList button can also be found here, allowing you to go back and edit your connection
settings.

-Run these commands on connect - Same as the commands tab in step 2.4.

4 - Tips
-Right click a channel in the channel list to access a wide variety of setting. Such as nicklist toggle, highlight toggle, and log view.

-By default AdiIRC has a few shortcuts to save precious seconds off our busy lives. When you want to PM a user, instead of /query you can use /q. /j
instead of /join and /w instead of /whois. Many of these options can also be found via right click.

-If you know how to make user commands, these can be found under Tools > Edit Aliases.

-The serverlist settings from step 2 can also be found at Server > Serverlist or Ctrl+S by default, allowing you to go back and edit your connection
settings.

m mIRC

A step by step guide to getting mIRC (an IRC client for Windows) up and running with the Fuel Rats IRC for first time users

Contents Related articles
1. Installing mIRC * |IRC FAQ
2. Connecting to the Fuel Rats IRC server ® |RC Client Setup Guides
3. Authentication and auto-joining channels
4. Changing the appearance
5. Sounds and Alerts Download mIRC
6. Tips and Tricks

mIRC Help Resources

1 - Installing mIRC

Installation for mIRC is very straight forward. Follow the instructions in the installer with the default options being sufficient for use with the Fuel Rats
IRC.

'Automatically Check for Updates' is recommended - mIRC will check if there is a newer version when starting the client.
The 'Portable Application’ option stores mIRC settings in the program directory so it can easily be copied to another computer, although you may have
to install mIRC to a different location (for example D: drive, or a USB stick) to avoid having to run the client as Administrator.

@ Non-portable mode (default option) settings location

%APPDATA%\mIRC
This is normally C:\Users\<your_username>\AppData\Roaming\mIRC

2 - Connecting to the Fuel Rats IRC server

When first starting mIRC you are presented with a window to enter your registration details. There is also the ability to evaluate the client if you don't
have registration details to hand.


https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-mirc-installing
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-mirc-connecting
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-mirc-auth
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-mirc-appearance
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-mirc-alerts
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-mirc-tips
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
http://www.mirc.co.uk/get.html
http://www.mirc.co.uk/help.html

After completing that initial process you are presented with the mIRC Options window:

mlRC Options

Category:
:
Servers
Options Mickname: | Rating[PC] |
Identd Alternative: | Ratling |
Proxy
Local
+ IRC Mame: | Ratling |
* Sounds Email: | (optional) |
+ Mouse
+ DCC
+ Display Server: EFnet: Random server
+ Other
[ New window
Connect
Cancel Help

Enter your primary and secondary IRC nicknames. These should match your registered IRC nick(s) (see the IRC FAQ ).

Next, move to the Servers sub category and you will most likely see a long list of popular IRC networks. For simplicity, these have been removed from
this guide to avoid confusion. Click on 'Add' to begin adding a new network:

mlRC Options

Category:

- Connect
IRC Servers:
Options
Identd - -
Proxy
Local

IRC

Sounds

Mouse
DiCC Sort
Display
Other

| F FH FHFHF

QK Cancel Help

A small popup 'Edit Server' window will appear. Enter details as follows:


https://confluence.fuelrats.com/display/FRKB/IRC+FAQ

Edit Server

Description: | FuelRats |

IRC Server: | irc.fuelrats, com |

Ports: | +6657 |

Group: | (optional) |

Password: | (optional) |

Cancel Help

Take care to ensure all of these details have been entered correctly. The server is irc.fuelrats.com and the port must be +6697. Ensure the
description is FuelRats as we will reference this name later on.

Click OK to return to the mIRC Options window and move down one line to the Options sub category:

mIRC Options

Category:
- Connect A
Servers
rm— Connect on startup Perform...
Froxy Reconnect on disconnect
Local []Show connect on startup Refry...
= IRC . Move to top on connect 55L...
Options
Messages Ched: connection time out Porte
Catcher [ ]Prezerve nicknames =
Logging IJse invisible mode
Flood
=1 Sounds
Requests Default Port: | +0697
Speech
=l Mouse
Drap W
Conce || e

As before, ensure your settings match those shown above.

In the Messages sub category you may wish to enable Timestamp events (seeing times in the chat while ratting is useful). Stripping color codes from
incoming messages is a personal preference (can be useful to avoid other users spoiling your color settings!).



mIRC Options

Category:

= Connect LS
Servers
Options Timestamp events: | [HH:nn] |
Identd
Proxy Strip codes from incoming messages:

IRE':":E" Color [Jother []If more than:

Options
Messages Ctep finger reply: | |
Catcher
Logging Quit message: | |
Flood
-l Sounds Split long channel fquery messages
Requests
Speech
=l Mouse
Drop W

LITF-5 encodefdecode messages

Cancel Help

Before moving on, some other settings you may wish to consider within the mIRC Options window:

® Display Options
Click on the Marker button and uncheck "Show line marker"
® Other Window buffer
Increase if you like being able to scroll back a long way
® Connect Options Ports (button)
Enable IPv6 support if you have IPv6 on your internet connection

You should now have FuelRats in your Servers list:

mlRC Options

Category:

= Connect LY

IRC Servers:
Options FuelRats

Identd
Proxy Add
Local

= IRC
Options Delete
Messages
Catcher Sort
Loagaing
Flood
Requests ' '
Speech

-l Mouse
Drop W

Edit

oK Cancel Help

Make sure FuelRats is selected from the list and then click the Select button. You will be returned to the Connect page at the top of the category list.
Click the Connect button to log into the Fuel Rats IRC server (you won't have to do this again, next time you load mIRC it will connect automatically).



On your first connect you may see a message like this:

Certificate
Lﬁl Connecting to irc. fuelrats, com (+6897)
il Y g . :

Your connection to this server is encrypted, however there is a problem with
the server's security certificate.

summary ~
Unable to get local issuer certificate

Issuer

Organization: Let's Encrypt
Host: Let's Encrypt Authority X3
Country: US

Subject
Host: irc.eu. fuelrats.com
Dins: irc.eu, fuelrats, com, irc. fuelrats, com, kivi. fuelrats.com

valid from 13/01/2017 to 13/04/2017 v

If you trust this certificate, dick OK to continue connecting to the server,
atherwise dick Cancel to cancel the connection.

[~]:Automatically accept this certificate in future!

Cancel

Select to automatically accept and click OK.

llie
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Congratulations! You have connected to the IRC.



3 - Authentication and auto-joining channels
This section guides you through configuring mIRC to automatically authenticate and join channels when you connect to the FuelRats network.

The IRC FAQ guides you to registering IRC nick(s). If not already done, please follow that guide first to set up your account. Once you have opened
your account and registered your IRC nick(s) please continue!

Now that you are connected to the Fuel Rats IRC server, press ALT+R (in mIRC) or click on the Tools menu and select Scripts Editor

Tools  Commands  Window Help

Channels List... Alt+L
Scripts Editor... Alt+R
Send File... Alt+5
Chat... Alt+C

Received Files...

Laog Files..,

Address Book... Alt+B
Online Timer... Alt+l
Clear History... Ctrl+ Shift+Drel
Options... Alt+0

The mIRC Scripts Editor window will pop up. Select the Remote tab.

"F& mIRC Scripts Editor - remote.ini

File Edit View Listen Options Help

Alizses Popups Remote Users Vanables &
on *:inotice:*nick* 13 registered*:#*:|
if ({snetwork == FuelBats) sz (fnick == nickserwv) |
.m3g $v2 identify YOUR_FPASSWORD

on *:notice:Password accepted*:#*:]
if (&network == FuelRats) |
.join #FuelBats
.Join #Ratlhat
dindow -n "Status Window™

File: scriptsiremate.ini 1:12/14(0.3k)

Concel || b

Copy and Paste into this editor the following:



https://confluence.fuelrats.com/display/FRKB/IRC+FAQ

on *:notice:*nick* is registered*:*:{
if ($network == Fuel Rats) && ($nick == nickserv) {
.msg $v2 identify YOUR PASSWORD
}
}

on *:notice: Password accepted*: *:{
if ($network == Fuel Rats) {

.join #Fuel Rats

.joi n #Rat Chat

.window -n "Status W ndow'

}

}

You will notice on line 3, YOUR_PASSWORD needs to be replaced with your IRC password that you set in your account. This is private to you, do not
show anybody else this information.

What does this do?
® When you are connecting to the FuelRats server (we spoke earlier about why the spelling is important) and nickserv asks you to identify, this
script automatically authenticates for you
® When nickserv confirms your password is accepted, this script automatically joins the two important channels #FuelRats and #RatChat
® Finally, the script automatically hides the Status window so it doesn't get in your way

Of course you can add additional lines as required.

Once happy, click the OK button to close the window. The next time you load mIRC you will automatically authenticate and join #FuelRats and #RatC
hat.

4 - Changing the appearance

Despite what may appear to be a restrictive interface on first glance, mIRC can be extensively customized and is extremely versatile! It's not possible
to cover all combinations however this section will demonstrate how to transform the default mIRC into a dark theme with an entirely different layout.

Here is our default mIRC. We're connected to the two default channels #FuelRats and #RatChat
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Let's get rid of that toolbar at the top and while we are at it the big blank area to the left! Go to the View menu and uncheck Toolbar and Treebar.

View Favorites Tools Comr
~  Menubar

Toolbar [
~  Switchbar

Treebar

Favarites >

Mode >

Motify List Alt+M
Lrls List Alt+U

Colors... Alt+E
Font...

Full 5creen F11
On Top

Here's how it looks now:
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[25 FuelRats Ratling[... |=| #uelrats |£l] #RatChat

5 Status: Ratling[PC] [+iwaxz] on FuelRats (irc.eu.fuelrats.com:+6697) (01:20)
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Lets keep working on it. How about we move the Switchbar down to the bottom. Fortunately there is a little grapple on the left side of the bar. Lets
have a look:

Fi View Favorites

' FuelRats Ratlingl...

’

Grab this and drag the bar to the bottom (you can right click to lock the bar in position too). While you're at it, lets minimize the Status Window, just
click the minimize button to get rid (next time you load mIRC it will get hidden automatically).

mIRC now looks like this:



File View Favorites Tools Commands Window Help

|- | #RatChat (FuelRats, Ratling[PC]) [111] [+Gnri]: Problems? http://tfuelr.at/help | READ: FR Knowledge Base: http://t.fuelrat/frkb | Training: http://t... | = || B [s3a]
~ ™irange_§

&RatMama[
@EAbsolver
@aitken
@Becci
@Bold_Mol
@Calomiri
@Clapton
@ECrunchyb
@Dystopia
@Dystopia
EMangel
@MasterLo
@ETrezy
%Discord
%Hechasqu
+_Albuca_
+Adanaran
+altf3[PC
+Antarcti
+Artemis3
+Blue_.Jad
+borbra
+carneous
+D@lphin
+Daoud_al
+Delta_RC
+denfloro
+esxste
+Falcon_J
+Faultytu

* How talking in #RatChat v +Fighting «

[25 FuelRats Ratling... |=|#uelrts |= | #RatChat

After minimizing the Status window there are two other channels open. #FuelRats and #RatChat. They are both open but one is covering the other.
Lets organize these two windows.

Resize the main mIRC program to the dimensions you wish and then click the Window menu and select Tile Horizontal:
Window Help

Tile Horizontal

Tile Vertical

Cascade

Group... i
Order...

Close Alt+Z |

1 FuelRats Ratling[PC]
2 #Ffuelrats (FuelRats, Ratling[PC]) [107] [+nrt]: Need Fuel? !
~ 3 #RatChat (FuelRats, Ratling[PC]) [105] [+fGnrt]: Problems?

mIRC should now look somewhat like this:



File View Faverites JTools Commands Window Help

il

<+Raven_Hightingale[Dispatch]> toynt[PC|UK], sure ok
<+Raven_MHightingale[Dispatch]> ttweet pcrats in colonia needed for cr
{TweetSqueak[BOT]> Your message has been tweeted.

* TweetSqueak[BOT] was kicked by RatMama[BOT] {Stop repeating yourselft)
Halthbern[PC]_ is now known as Halthbern[PC]

RatMama[BOT] sets mode: +v Malthbern[PC]

TuweetSqueak[BOT] {(TweetSquea@Clk-8BEFA7OC.ip-37-187-192.eu) has joined #fuelrats
RatMama[BOT] sets mode: +h TweetSqueak[BOT]

Lapotor[PC|EU] (Lapotor@4FA9469CE.1DFB3E29.2E403B6A.IP) has joined #fuelrats
RatHama[BOT] sets mode: +v Lapotor[PC|EU]

+Dystopia {(Dystopia@netadmin.fuelrats.com) Quit (Quit: ..._exeunt stage right pursued by xlexious..)
<{+Lapotor[PC|EV]> is the colonia case up to date and is it important so cr or so ?
* Lapotor {Lapotor@4FA969CB.1DFA3E29.2E483B6A.IP) has joined #fuelrats

* RatMama[BOT] sets mode: +v Lapotor

<+Raven_Nightingale[Dispatch]> Lapotor[PC|EU], hes away right now
<+Lapotor[PC|EU]> rgr

* +Lapotor[PC|EU] (Lapotor@lapotor.overseer.fuelrats.com) has left Hfuelrats

#* Lapotor[PC|EU] (Lapotor@lapotor.overseer.fuelrats.com) has joined #fuelrats

* RatMama[BOT] sets mode: +u Lapotor[PC|EU]

* +Dystopia[PC|artwork] (™~DystopiaP@netadmin.fuelrats._com) Quit {Read error)

® oK K % ¥ ok %

o || = [ &

~0range_3heets -
&RatMama[BOT]
@Absolver

@aitken

@Becci
BCalomiriel[away]
@Clapton
@CrunchyBaton955
@EMangel
@MasterLoon[PC]
@Trezy
%MechaSqueak[BOT]
%TweetSqueak[BOT]
+_Albuca_

+Adanaran

+altf3[PC]
+Antarctica@1[0fFF-I
+Artemis387[PC]
+Blue_Jade[0D]

v +horbra w

>

<@Dystopia[PC|artwork]> Eddb.io

<+0lujal> thx

<+TimberBuff[XB1]> I can get a nice Python for about 168 mil

<+TimberBuff[XB1]> To do combat/missions

<+TimberBuff[XB1]> I'11 need to mod the FSD tho, jeez

<@Dystopia[PC|artwork]> Hn

* @Dystopia (Dystopia@netadmin.fuelrats.com) Quit {Quit: ...exeunt stage right pursued by xlexious..)

* Lapotor {Lapotor@4FA969CB.1DFB3E29.2E403B6A.IP) has joined #RatChat

* RatHama[BOT] sets mode: +v Lapotor

* Loetmichel (cyllyEC1lKk-BA418815.dipA.t-ipconnect.de) Quit {Ping timeout: 188 seconds)

{@BMasterLoon[PC]> Lapotor, its uptodate

* Loetmichel (cylly@C1k-AF76608C2.dipA.t-ipconnect.de) has joined #RatChat

<+TimberBuff[XB1]> Gim balled or turreted on a Python?

{@MasterLoon[PC]> personal preference...

<+The_armed_581st> Everybody knows where you go vhen the sun goes down I think you only live to see the
lights of town I wasted my time when I would try try try because when the lights have lost their glow
you'll cry cry cry

<+TimberBuff[XB1]> Hmm, how's it's turning speed? I've never flown one

<+Winscer[PC|EU]> It's decent, but don't expect to outmaneuver smaller ships

* @Dystopia[PC|artwork] (™~DystopiaP@netadmin.fuelrats_com) Quit {Read error)

|| #RatChat (FuelRats, Ratling[PC]) [104] [+fGnrt]: Problems? http://t.fuelr.at/help | READ: FR Knowledge Base: http://tfuelr.at/frkb | Training: http://tfuelrat/training | Help ustestt.., | = || = |[m3]

~ ~Orange_Sheets A
&RatMama[ BOT]
EAbsolver
EAitken
@EBecci
BCalomiriel[away]
Eclapton
@CrunchyBaton955
EMangel
E@MasterLoon[PC]
@Trezy
%Discord
%MechaSqueak[BOT]
+_Albuca_
+Adanaran
+altf3[PC]
+Antarctica@1[0FF-I
+Artemis387[PC]
+Blue_Jade[0OD]

v +horbra w

[25' FuelRats Ratlingl... =] #uelrats =] #RatChat

In this example #FuelRats is at the top as it is your first joined channel, #RatChat is below. If you are happy with the position of each sub window, click

on the icon in the top left and select Position Save (for each sub window).



I mIRC

File View Favorites Tools Commands Window Help
| #fuelrats (FuelRats, Ratling[PC]) [97] [+ nrt]: Meed Fuel? type 'Ra

Desktop
Cn Top
Background »
Beeping ¥
Buffer »
Flashing -]
Logging »
Position -] Clear Default
Spacing * Set As Default
Speech -] Recet
Tirnestamp » Save
= ’ Clear |
Edit Box.. Reset Al
Events.. Save Al
Font.. Clear Al

- Blicl it |

There are various options in the menu to override global settings per channel. One example would be to move the nick list to the left side. Click on 'Nic
k List..." and change the option accordingly:

Mick List

Position:
left w~

[] Auto-hide nick list

Show nick list on Shift+Tab

[ ]Reszet default
[] use default

] set as default for all channels

Corcel

Once again - select 'Set as default for all channels' if that is the setting you wish to apply to all channel windows.

Things are looking somewhat more organised. Lets look into fonts and colors.

To change the default font, click on the 'View' menu at the top followed by 'Font...'



Font:

|Luc1'|:la Console e

Size: Style:

10 e Regular e
AaBbYyZz

Set as default for channel windows

Cancel

Select 'Set as default for channel windows' to apply the change to your open channel windows. You may find fixed width fonts are easier to read (e.

g. Lucida Console, Fixedsys, Consolas, and so on...).

To change text and background colors, click on the 'View' menu at the top and 'Colors...'

Scheme:
Dark o Mew Delete

Appearance:

Own text

e .

| Editbox text ] Inactive _______|

QK Cancel Help

Reset

You can create a new color scheme by clicking 'New' at the top and giving it a name. In the above example colors have been chosen to work with a
black background. To change the background colors click on the blank spaces. To change individual text colors click directly on the text you wish to
change and pick a color at the bottom. Once you are happy, click OK and your color scheme will be applied.

Example dark color scheme:
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|- | #RatChat (FuelRats, Zatie[PC]) [99] [+fGnrt]: Problems? http://t.fuelr.at/help | READ: FR Knowledge Base: http://t.fuelr.at/frkb | Training: http://tfuelr.at/training | Help us test the latest version ... EI@

Great work CMDR, you've successfully changed the appearance of mIRC. Go forth and experiment!

5 - Sounds and Alerts

As a Fuel Rat it's important (perhaps essential!) to know when a new case is arriving, or when another rat mentions your name without having to keep
one eye glued to the IRC window all the time.

The mIRC Address Book requires a few basic changes to ensure you are "pinged” when a new client arrives. The trigger for most new cases is Ratsig
nal and it would be useful for mIRC to notify you when a new case arrives.

(D Squeaking!

Take care not to write Ratsignal in the IRC chat! You'll squeak and everybody will hear! Beware!

To open the mIRC Address Book, press ALT+B or click on ' Tools ' on the main menu and ' Address Book... '



mlRC Address Book

Users Whois Modtify Caontral Mick Colors Highlight

Enable highlight

ratling Add
incoming dient :
need fuel Edit
Delete
Up
Down

Cancel Help

A few examples are shown above. Ratsignal being the most important notification. You may wish to highlight your name as | have done!

Select 'Enable highlight' and click 'Add' to create a new rule.

Lets take a look at the first two examples. The Ratsignal:

Edit Highlight

Highlight lines that contain these words:

|

Match on:

Message o [ ] Case sensitive
[]Regex

Color:

> |

Play sound:
ratsignal. wav b time(s)

[ ]Flash message

QK
|:| Tip message: - SeCs
ER —
Message:
| Help

In this case any line that contains Ratsignal is written in red and ratsignal.wav is played.

@ Sound files can be stored in the %APPDATA%\mIRC\sounds folder
This is normally C:\Users\<your_username>\AppData\Roaming\mIRC\sounds



A second highlighting example for your own name(s):

Edit Highlight

Highlight lines that contain these words:

ratling
Match on:
Message o (] Case sensitive
[]Regex
Color:
v]
Play sound:

ding.wav » time(s)

Elash message

[ Tip message: SECS

Message:
| | Help

Cancel

Here we use a different color and sound. The 'Flash message' option is checked which also flashes mIRC in the titlebar and taskbar. This can be
useful if you are AFK for some time. When you return to your PC mIRC will be flashing reminding you there has been a message to with your name in
it.

Example highlighted Ratsignal text:

File View Favorites Tools Commands Window Help

=8

6 - Tips and Tricks

Did you know you can use the tab button while typing a message to automatically complete another user's name? By typing the first 2 or 3 letters and
then pressing the tab key, you can cycle through nickname matches without having to type the full name. Very handy to avoid spelling mistakes!

You can copy text by simply highlighting it with the mouse. There is no need to press CTRL+C.

You can set a background image in your chat windows by clicking the little icon (top left corner) and selecting Background Select...
Setting the default position for channel windows is different to the default position for private messaging windows.

If you have any useful tips, let us know!

Good luck CMDR, and fly safe with mIRC! o7

blocked URL Textual

A step by step guide to getting Textual (an IRC client for macOS) up and running with the Fuel Rats IRC for first time users


https://www.codeux.com/textual/private/images/v600index/applicationIconMedium.jpg

Contents Related articles

1. Installing Textual ®* |RC FAQ

2. Connecting to the Fuel Rats IRC server ® |IRC Client Setup Guides
3. Authentication and auto-joining channels

4. Sounds and Alerts

5. Tips and Tricks Download Textual

Textual Knowledge Base

1 - Installing Textual

You can purchase Textual from the Mac App Store or from codeux.com, a 30-day trial is also available on the website.
If you wish to purchase it from the Mac App Store it will simply install to your /Applications and you can run it.

If you choose to purchase or trial it from codeux.com you simply press the "Try Textual for 30 days" button and a disk image file should download.
When downloaded, double-click the disk image file in Finder and drag the Textual.app to the /Applications directory.

2 - Connecting to the Fuel Rats IRC server

When first starting Textual you are presented with a welcome window, press continue.

® Textual

Welcome to Textual!

To get started, select a network to connect to
using the the control labeled "Destination” or
manually enter the desired server address.

Destination: | Fuel Rats
Nickname:
GameSurge
GeekShed
GeeksIRC
German-Elite

Channels:

Te or
th ar

+ Connect on launch

Additional options including NickServ
password, username, real name, etc. can be
edited later by control clicking the connection
and selecting "Server Properties"

Cancel Start Chatting
Send |

In the Destinations field scrolldown until you see "Fuel Rats" and select it.

Enter your nickname. IT should match your registered IRC nick(s) (see the IRC FAQ ).

In the channels field, make two entries, one for #fuelrats and one for #ratchat


https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-textual-installing
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-textual-connecting
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-textual-auth
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-textual-alerts
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-textual-tips
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
https://codeux.com
https://help.codeux.com/textual/
https://codeux.com
http://codeux.com
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ

[ON Textual

Welcome to Textual!

To get started, select a network to connect to
N 4 using the the control labeled "Destination” or
4 manually enter the desired server address.

Destination: | Fuel Rats
Nickname:  Ratling[PC]

Channels: | #fuelrats
#ratchat

Te or
th i
+ Connect on launch
Additional options including MNickServ
password, username, real name, etc. can be

edited later by control clicking the connection
and selecting “Server Properties”

— Cancel Start Chatting -
Send |

Check the Connect on launch checkbox and click Stat Chatting.

Congratulations! You have connected to the IRC.

3 - Authentication

This section guides you through configuring Textual to automatically authenticate when you connect to the FuelRats network.

The IRC FAQ guides you to registering IRC nick(s). If not already done, please follow that guide first to set up your account. Once you have opened
your account and registered your IRC nick(s) please continue!

Now that you are connected to the Fuel Rats IRC server, right click the Fuel Rats entry in the server list and select Server Properties, or press U

P aene

ra Disconnect B
*hé  Channel List... N
Change Nickname... i
Add Server...
Duplicate Server '-'":'
Add Channel... 3+

d
Server Properties... #U

[T16:32:251T- Te

In the Server Properties window select Identity in the list.


https://confluence.fuelrats.com/display/FRKB/IRC+FAQ

[ ] Ratling[PC] on FuelRats IRC Network — irc.us.fuelrats.com o

| | ¥ Basic Settings
i

e Address Baok Nickname: Ratling[PC] such
Channel List

Connect Commands Away Nickname:
toptional)

Encoding o
Alternative Nicknames:

(optional) S

General

B This field is space separated
Identity

Highlights
Messages Username: _ textual
¥ Vendor Specific
ZNC Bouncer Real name: | Textual User
¥ Advanced
Client Certificate
Floed Cantrol Personal Password: | essesses|
Network Socket fepiens) |
Proxy Server Wait for identification before joining channels | Tl

fcues.

Cancel ave

+ -3 1 Send message..

In the Personal Password field enter the password you used to register your nickname on fuelrats.com, and check the "Wait for identification before
joining channels" checkbox.

Once happy, click the Save button to close the window. The next time you load Textual you will automatically authenticate and join #FuelRats and #Ra
tChat.

4 - Sounds and Alerts

As a FuelRat it's important (perhaps essential') to know when a new case is arriving, or when another rat mentions your name without having to keep
one eye glued to the IRC window all the time.

Textual requires a few basic changes to ensure you are "pinged" when a new client arrives. The trigger for most new cases is Ratsignal and it would
be useful for Textual to notify you when a new case arrives.

@ Squeaking!

Take care not to write Ratsignal in the IRC chat! You'll squeak and everybody will hear! Beware!

To open the Textual highlights list, press , or go to the Apple menu in the menubar, and select Preferences

About Textual
Services >

Hide Textual #EH
Hide Others LEH

Quit Textual & IRC 30

Select the Highlights tab


http://fuelrats.com

[ ] Textual Preferences

©Q U & L EO uw &

General Highlights Motifications Behavior Controls Interface Style Addons  Advanced

Log highlights to separate window

Full Word Matches [
H Highlight current nickname
Highlight words: Exclude words:
ratsignal
F F

In the Highlight words list press the + button to add a new item, and enter ratsignal

Make sure the "Highlight current nickname" checkbox is checked.

5 - Tips and Tricks

Did you know you can use the tab button while typing a message to automatically complete another user's name? By typing the first 2 or 3 letters and
then pressing the tab key, you can cycle through nickname matches without having to type the full name. Very handy to avoid spelling mistakes!

You should now be set up and ready! Fly safe CMDR o7

blocked URL IRCCloud

A step by step guide to getting IRCCloud (an IRC client for web browsers, Android, and iOS) up and running with the Fuel Rats IRC for first time users

1 - Getting IRCCloud

You can sign up to IRCCloud from irccloud.com or by downloading it in the Google Play Store or Apple App Store

IRCCloud offers paid subscriptions but also has a free plan that disconnects you after a period of inactivity, this is perfectly fine for Fuel Ratting.

2 - Connecting to the Fuel Rats IRC server

Before you continue, make sure you confirm your email address, IRCCloud will not let you connect until you have done so.

Once you have registered your IRCCloud account you are presented with a login


https://pbs.twimg.com/profile_images/3434795416/13a821285aecb9ad1b71b12a3d5a237f_400x400.png

Logout New Connection Save
SERVER SETTINGS

Network Choose a Network
Hostname irc.fuelrats.com
Port 6697

Use SSL b

YOUR IDENTITY

Nickname john
Real name John Smith
PASSWORDS

NickServ e000000000000000
Server

CHANNELS TO JOIN

In the hostname field enter irc.fuelrats.com enter 6697 as Port and check the Use SSL checkbox.

Enter your nickname. IT should match your registered IRC nick(s). The IRC FAQ guides you to registering IRC nick(s) . If not already done, please
follow that guide first to set up your account. Once you have opened your account and registered your IRC nick(s) please continue!

In the NickServ field enter the password you used to register your nickname on fuelrats.com

In the Channels to join field, make enter #fuelrats and #ratchat, seperated either by a space or a comma.


https://confluence.fuelrats.com/display/FRKB/IRC+FAQ

Logout New Connection Save

YOUR IDENTITY

Nickname john
Real name John Smith
PASSWORDS

NickServ e0o00c0000000e
Server

CHANNELS TO JOIN

#{uelrats, #ratchat

COMMANDS TO RUN ON CONNECT

Name

Hostname Port

Full name (optional)

ptions

NickServ password — if the se SUpPO:

Commands to run on connect —

rver password — (optional) for pri

You can now press save Save.

Congratulations! You have connected to the IRC.



3 - Sounds and Alerts

As a FuelRat it's important (perhaps essential') to know when a new case is arriving, or when another rat mentions your name without having to keep
one eye glued to the IRC window all the time.

IRCCloud requires a few basic changes to ensure you are "pinged" when a new client arrives. The trigger for most new cases is Ratsignal and it
would be useful for IRCCloud to notify you when a new case arrives.

@ Squeaking!

Take care not to write Ratsignal in the IRC chat! You'll squeak and everybody will hear! Beware!

To open the IRCCloud highlights list, press the cog wheel icon to the right of the input bar and select Settings

Disconnect

Edit Connection

Ignore List

Add Network

Join a Channel

Display Options

Settings

Send Feedback

Logout




ull Telia N-WiFi Tale = 23:27 C@<v3%66%mm)

Cancel Settings Save
HIGHLIGHT WORDS

RATSIGNAL

MESSAGE LAYOUT

Nicknames on Separate Line W,
Show Real Names W,
Right Hand Side Timestamps W,

User Icons
Compact Spacing
24-Hour Clock

Show Seconds

Usermode Symbols

@, etc

Colourise Nicknames

OLOLONE

In the Highlight words list enter the word RATSIGNAL

You should now be set up and ready! Fly safe CMDR o7

blocked URL AndrolRC

A step by step guide to getting AndrolRC (a free IRC client for Android) up and running with the Fuel Rats IRC for first time users

Contents Related articles
1. Installing AndrolRC ®* IRC FAQ
2. Connecting to the Fuel Rats IRC server ® |RC Client Setup Guides
3. Optional server settings
4. Auto-joining channels

Download AndrolRC

1 - Installing AndrolRC

AndrolRC can be found in the Play Store and installed for free here.

There is also a premium version available which comes without ads but does not add any new features.

2 - Connecting to the FuelRats IRC network

When first starting the app, there will be some preconfigured servers, but we will add our own. Head into Settings > Servers and click New server.


https://lh3.ggpht.com/25nNPDC984rlLhcbQFcj01d7YAfptj5q4QJmEVSNUJcztxHLapesGgCo2fWwZHkb6ys=w300
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-androirc-install
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-androirc-connect
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-androirc-optional
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-androirc-autojoin
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
https://play.google.com/store/apps/details?id=com.androirc&hl=de
https://play.google.com/store/apps/details?id=com.androirc
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< Servers New server < New server

freenode (EN) AndroUser Name

irc.freenode.net:6667 UTF-8 IRC server name

EpiKnet (FR) AndroUser Address

irc.epiknet.org:6667 UTF-8 IRC host or IP address

QuakeNet (EN) AndroUser Port

irc.quakenet.org:6667 UTF-8 Connection port (default: 6667)

UnderNet (EN) AndroUser Password

irc.undernet.org:6667 UTF-8 Leave empty if there's no password

KottNet (EN) AndroUser Nickname

irc.kottnet.net:6667 UTF-8 Specific server nickname
Alternative

Specific server alt. nickname

Ident

The menu we are then shown let's us configure the new server.

Name: This will be shown in the server list, FuelRats makes sense for our purposes.

Address: The FuelRats IRC host adress is irc.fuelrats.com.

Port: If you wish to connect without SSL, use port 6667. If you wish to enable SSL specify port 6697. (See below)

Password: Since the FuelRats IRC is not password-protected, we'll leave this blank.

Nickname: Your preferred IRC nickname, many rats like to use their CMDR name with spaces replaced by underscores _. Make sure you
have that nickname registered on the website.

Alternative: The fallback nickname in case your first choice is already taken upon connecting.

Ident: This is what will be shown before your host (Example: androirc@mhajoha.rat.fuelrats.com). androirc is the default and will be used if
this is left blank.

Your Nickname, Alternative and Ident can also be set globally in Settings > Nickname. Here you can set your Real name as well, which will be
visible to other IRC users in your user info. Specific server settings will override global ones if both are set.

3 - Optional server settings

Scrolling down a bit farther, we see some interesting settings.


https://fuelrats.com/profile/
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< New server < New server

Secured connection 0 Authentication
Use SSL for connection

Use SSL certificate 0
Enable SSL certificate authentication

Enable

Authentication service
Currently using SASL

SSL certificate filename

Certificate must be located in /storage/emulated/ Authentication type
0/AndrolRC/certs Currently using PLAIN
SSL certificate password Username
Leave empty if there's no password
Password
Auto-connect 0
Launch server connection on startup
Auto-join channels Auto-correction char.
Auto-join channels on server connection Automatically corrects channel names with the

chosen character

HL list
Show a HL as soon as someone says a word on

While we can connect to the FuelRats IRC with the setup we already have, these settings are worth looking at:

Secured connection: SSL (aka TLS) will encrypt data transfer between you and the server. While this is not necessatry, it is highly
recommended to use SSL regardless of the circumstances. If you check this box, you must use port 6697 above. If you do not wish to use
SSL, you must use port 6667.

HL list: Messages containing any words you add to this list will be highlighted and you will be notified upon receiving them. If you intend to
use AndrolRC as your main ratting client, you may want to add Ratsignal to that list so that you get notified when a new client arrives.

@ Squeaking!

Take care not to write Ratsignal in the IRC chat! You'll squeak and everybody will hear! Beware!

Authentication: You can set up the client so that you don't need to identify to NickServ everytime you connect. AndrolRC has two options
here:
© NickServ: The client will basically send the command /msg NickServ identify <password> for you, with Password being whatever
password you set on the website when you registered the nickname we set earlier. This approach is simple, but it works well.
© SASL: This option takes a username and a password. The username must be your main nickname, i.e. the first nickname you
registered on the website, and the password must be the password you have set for that nickname. The beauty here is that it will log
you in independent of the nickname you connect with (the one we set earlier), however that will still have to be registered in the API
for MechaSqueak to know who you are.
Auto-connect: Connects to the server as soon as you start AndrolRC.
Auto-join channels: Tick this box in order to be able to join channels on this server upon connection. See more below.

4 - Auto-joining channels

In case you get tired of having to type /join #ratchat and /join #fuelrats everytime you connect, you can set AndrolRC to join certain channels upon
connection automatically.

Go into Settings > Channels. Select the FuelRats server.


https://fuelrats.com/profile
https://fuelrats.com/profile/
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-androirc-autojoin
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SV GG eI [:{  Add a channel < Add a channel

#ratchat Channel name

#fuelrats Auto-join this channel

Auto-join must be enable on server
settings

Password
Key

Channel key if mode +k is set

FiSH key

Simply input the channel name and make sure "Auto-join this channel” is ticked. Since neither #fuelrats nor #ratchat use a keyword (= password),
there is no need to add one here.

@ In order for these changes to have an effect, you have to tick Auto-join channels in the server settings .

And with that, you should have AndrolRC all set up and ready to go. Go and fuel 'em, commander. 07

|+ Revolution IRC

A step by step guide to getting Revolution IRC (a free Early Access IRC client for Android) up and running with the Fuel Rats IRC for first time users

Contents Related articles
1. Installing Revolution IRC * IRC FAQ
2. Connecting to the Fuel Rats IRC server ® |RC Client Setup Guides

3. Optional settings

Download Revolution IRC

1 - Installing Revolution IRC

Revolution IRC can be found in the Play Store and installed for free here.

2 - Connecting to the FuelRats IRC network

To add a new server, click the + button in the bottom right.


https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-revolution-irc-install
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-revolution-irc-connect
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-revolution-irc-optional
https://confluence.fuelrats.com/display/FRKB/IRC+FAQ
https://play.google.com/store/apps/details?id=io.mrarm.irc
https://play.google.com/store/apps/details?id=io.mrarm.irc
https://confluence.fuelrats.com/pages/viewpage.action?pageId=13271082#IRCClientSetupGuides-androirc-optional
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Revolution IRC H <  Add anew server

Active

FUEL RATS

& irc.fuelrats.com
Inactive

Use SSL/TLS
Fuel Rats
Username with password (SASL)

NumberPi

NumberPi NumberPi[PC]

#ratchat #fuelrats

D Rejoin opened channels

Add a new server

| Use SSL/TLS

Username with password (SASL)

NumberPi

NumberPi NumberPi[PC]

#ratchat #fuelrats

[C] Rejoin opened channels

The menu we are then shown let's us configure the new server.

® Name: This will be shown in the server list, Fuel Rats makes sense for our purposes.
® Server Address: The FuelRats IRC host adress is irc.fuelrats.com.
® Port: If you wish to connect without SSL, use port 6667. If you wish to enable SSL specify port 6697. (See below)



® User SSL/TLS: This will encrypt data transfer between you and the server. While this is not necessary, it is highly recommended to use SSL
regardless of the circumstances. If you check this box, you must use port 6697 above. If you do not wish to use SSL, you must use port 6667.

® Server Password: The Fuel Rats IRC does not have a server password, so leave this blank.

® Authentication mode / Username / Password: The options here vary depending on which Authentication mode is set. SASL will suit
most rats. Username is a registered nickname (see below). Password is the password you chose when registering your first nickname.

® Nicknames: Your preferred IRC nickname(s), many rats like to use their CMDR name with spaces replaced by underscores _. Make sure
you have those nicknames registered on the website. They will be attempted to be used in the order they are listed.

® Auto-join channels: Channels that will be joined automatically upon connecting.

® Auto-run commands: These commands are run when you connect, and will only be required if you do not use SASL or Client Certificate
authentication to identify with NickServ.

Make sure to click the tick in the top-right when you're done.

Your Nicknames can also be set globally in ... > Settings > User Information. Here you can set your Real name and User as well, which will be
visible to other IRC users in your user info. Specific server settings will override global ones if both are set.

3 - Optional Settings
Also in ... > Settings are various other global options.
® Interface: Here you can set up how Revolution IRC looks. There is an extensive range of options and two default themes to get started.
© Nick/channel autocomplete: these offer various ways to complete nicks quickly and can be customised to suit your needs.
© Join/Part messages: It is recommended to keep these visible. While these might be annoying to some, knowing whether a client,
rat or dispatch disconnects is valuable information.
* Notifications: Messages containing any words you add to this list will be highlighted and you will be notified upon receiving them. If you
intend to use Revolution IRC as your main ratting client, you may want to add Ratsignal or a platform-specific signal to that list so that you get

notified when a new client arrives. Generally you will want Nick mentions and Private messages checked. Custom rules can be added with
the + button in the bottom-right. This will open various settings from a simple word, to complex regex and various options to notify you.

@ Squeaking!

Take care not to write Ratsignal or any platform-specific signals in the IRC chat! You'll squeak and everybody will hear! Beware!

And with that, you should have Revolution IRC all set up and ready to go. Go and fuel 'em, commander. 07

Useful highlights

Regardless of the client you end up using, you are probably going to want to set some highlights for specific events.

Here is a small list of useful highlights you may want to set, please see your respective client's setup guide for info on how to use these!

@ Heads up!

Be careful not to speak these phrases in casual conversation otherwise you will squeak and everyone will glare at you!

value description
RATSIGNAL | Raise the alarm! a client is out of fuel!
This highlight is used to notify rats that a client has arrived and needs assistance
PC_SIGNAL ' Raise the specific alarm! a Client in the PC universe is out of fuel!
This highlight is a more specific alarm than ratsignal, and is used to notify rats in the PC universe that a client has arrived and needs assistance.
PS_SIGNAL ' Raise the specific alarm! a Client in the ps4 universe is out of fuel!
This highlight is a more specific alarm than ratsignal, and is used to notify rats in the PS universe that a client has arrived and needs assistance.
XB_SIGNAL | Raise the specific alarm! a Client in the xbox universe is out of fuel!

This highlight is a more specific alarm than ratsignal, and is used to notify rats in the xbox universe that a client has arrived and needs assistance.
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